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Using this Guide

Contact Information

Please always check the product specific section on the Digi support website for the most current
revision of this document: http://www.digi.com/gatewaydevelopmentkit.

For more information about your Digi products, or for customer service and technical support, contact
Digi International.

To contact Digi International by Use

Mail Digi International
1101 Bren Road East
Minnetonka, MN 55343

U.S.A.
World Wide Web http://www.digi.com/support
Telephone (US) (952) 912-3444 or (877) 912-3444
Telephone (other locations) +1(952) 912-3444 or (877) 912-3444
Conventions used in this Guide
;rl;}f.‘; This icon indicates a step that has the potential to be
B || . . . .
e -’i’ o troublesome. Further information regarding items
,E.E:{{:‘: N marked with this symbol can be found in Appendix D:
o B Troubleshooting on page 79.
This icon indicates a hint, or concept that is learned.
=

This icon indicates a warning of the potential for
confusion or danger.

This icon indicates that a goal of the kit has been
completed.
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Introduction to the iDigi® Gateway Development Kit -
Wireless WAN Version

Thank you for purchasing an iDigi Gateway Development Kit. The kit is designed to make it easy
to setup an XBee network, upload a custom iDigi Dia application, and provide seamless
connectivity to the iDigi Cloud for web services integration to standard business applications
over the Internet. Before you start working with the kit, let’s cover some basics.

Goals of the Kit

As you go through the steps in this kit, you will:

1. Configure the Wireless WAN interface of the ConnectPort X4.

2. Create an iDigi developer account on the iDigi M2M operating Cloud.

3. Setup and configure the physical elements of an XBee wireless network and understand
how the network is managed through a ConnectPort X4 gateway.

4. Use the Digi ESP for Python IDE to build, download, and launch an iDigi Dia application
for your ConnectPort X4 gateway, then interact with the application in a realistic setting.

5. Use the iDigi Manager Pro Web Services Console to send a web service request to the
ConnectPort X4 retrieving the current XBee devices’ sensor readings.

6. Use the iDigi Gateway Development Kit Demonstration Application to understand how
an Enterprise application could use the iDigi Web Services APl to monitor the data
gathered by the XBee devices’ sensors.

Requirements of the Kit

System Requirements

To install the software mentioned in the Getting Started Guide, you will need a PC running Microsoft
Windows XP, Vista or Windows 7.

Web Browser Requirements

Microsoft Internet Explorer 7.0 or newer
Google Chrome 4.0 or newer
Mozilla Firefox 3.0 or newer

Additional Requirements

This Getting Start Guide assumes a scenario where there are no other XBee wireless devices in
the area (other than the ones provided with this kit) and that the local network has an Internet
connection.

| Note: If other XBee networks are present and open for joining, the XBee Sensor and XBee Smart
| Plug may join the wrong network. Please refer to the “XBee devices fail to join the ConnectPort
X4’s network” section of Appendix D: Troubleshooting on page 79 for more information.
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Part 1: Setup your Digi® Gateway Development Kit

Step 1: Kit Preparation

Identify Your Kit Components

Carefully unpack and verify the contents of your kit.

XBee Sensor *XBee Smart Plug

& 6

*Non-US kits: Wall Router

Ethermnet Cable Power Supply
7 —’c
N =4
e
XBee Antenna

ConnectPort X4

“Read me first” Insert

*Power Cord

>R,

*Not indudead in the X4-£1T-CO3-W

Cellular and WiMAX Antennas

XBee Smart Plug
Safety and

Certifications Insert

Figure 1: Kit Components

The table below indicates the type and quantity of cellular or WiMAX antennas included in your kit.

Ant Sprint Verizon AT&T Generic WiMAX
ntenna X4K-Z1U-C1011-A1 | X4K-Z1U-C2011-Al1 | X4K-Z1U-H2011-Al | X4K-Z1U-U7011-A1 | X4K-Z1U-C6011-Al
A 1 1 1 1 1
B 2 2
C 2 2
D 2
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Step 2: Unpack and Set up the ConnectPort X4

To begin setting up your iDigi Gateway Development Kit, you will need to connect the antennas
to your ConnectPort X4, connect your PC’s Ethernet cable to the ConnectPort X4, and then
power on the ConnectPort X4, and then form your XBee network.

Figure 2: Connecting Hardware

1. Remove the ConnectPort X4 from the box and attach the XBee antenna to the unit.

Attach the Cellular or WiMAX antenna(s) to your ConnectPort X4.

3. Connect the power supply to the ConnectPort X4 and then plug the power supply into a
wall outlet.

N

Note: The power supply has a twist-locking connector, ensure that the connector is
locked into place.

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version



Step 3: Configure the ConnectPort X4

Note: By default, ConnectPort X4 Wireless WAN models are configured with a static IP Address of
192.168.1.1 for the Ethernet interface, and they are configured to act as a DHCP Server. This
configuration simplifies the initial configuration of the unit.

1. Connect one end of the Ethernet cable to your PC, and the other end to the ConnectPort
X4 Ethernet port (ensure that your PC is configured to obtain its IP address via DHCP).

2. Open the Web interface of the ConnectPort X4 by navigating to the 192.168.1.1 address
in a Web browser on the PC and you will see a screen similar to the following:

£ CannoctPort X4 Configuration and Managoment - Mozilla Firefox
Ble Edt  Yew Hgloy Bookmads Took Hep

t’ - O at ] hempc 19 168, 1. 1o b -| g J
| ComnectPart X4 Condiguration and M. *
4 ConnectPort X4 Configuration and Management
' ’ :

Getting Started

Tutarial ot sure what to do newt? This Tutorial can help.

System Summary
Madel: ConnectPort X4

Ethernet MAC Address: 00:40:90: 4F:DE:E2

Ethemet IF Address: 192.168.1.1
Mabile 1P Address: Hot Connected

Description:  None

Device 10 00000000~-00000000-004090FF -FF4FD5SEZ

Copyright © 1996-2011 Digi Internstionsl Inc. All rights reserved.
wiww digi com

Figure 3: Web Interface

3. Configure the ConnectPort X4 Wireless WAN and Ethernet interface. Select the
Appendix below that best matches the Wireless WAN interface of your ConnectPort X4.

Note: For more information on how to properly configure the ConnectPort X4 Wireless
WAN interface, refer to the following Appendix:

Appendix A: Configuring for a GSM/Edge cellular network (AT&T)
Appendix B: Configuring for a CDMA cellular network (Verizon)
Appendix C: Configuring for a CDMA cellular network (Sprint)
Appendix D: Configuring for a WiMAX network

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version
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Once you have followed the configuration examples for the Wireless WAN interface in the appropriate
Appendix, continue with the following sections below:

Configuring the ConnectPort X4 IP Gateway Priority

Once the ConnectPort X4's mobile interface is connected, it could conceivably reach the Internet via
either of its network interfaces (Mobile or Ethernet). Configuring the ConnectPort X4 Gateway Priority
List determines the priority for each of its network interfaces. By default the ConnectPort X4 gives the
Mobile interface the highest priority.

The ConnectPort X4 IP Gateway Priority List and the DNS Priority List are configurable via the
Configuration > Network > Advanced Network Settings page, as displayed below: (Gateway Priority will
display WiMAX for WiMAX units.)

w Advanced Network Settings

The following settings are advanced settings used to fine tune the network connection and network
interfaces. The default settings will typically work in most situations.

IP Settings

Host Name: |

Static Primary DNS: ID.D.I}.I}

Static Secondary DNS: ID.D.D.I}

DNS Priority: Maobile

Ethernet =| ¢

o
Gateway Priority: Ethemet ~|
C

See also IP MNetwork Failover Settings for default gateway management.
DMNS Proxy Settings

¥ Enable DNS Proxy Service

Request Cache Size Maximum: IEES entries (16-1024)
Figure 4: Advanced Network Settings

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version
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Configuring the Ethernet Interface

Now that the ConnectPort X4’s mobile interface is configured, you will need to configure the Ethernet
interface. The Ethernet configuration changes will involve disabling the DHCP Server and determining
how the ConnectPort X4 will be given its IP address.

1. Click on Configuration > Network from the left-hand menu. You should see the Network
Configuration screen (with the Ethernet IP Settings page displayed by default) as shown:

ConnectPort X4 Configuration and Management

\Diar

L

@ Heb

Home Network Configuration

Confi ti q
entiguration ¥ Ethernet IP Settings

Metwork
rohbile
WEes Metwork O Obtain an IP address automatically using DHCP *
Serial Ports @ use the following IP address:
camer * 1P Address: | 192.168.1.1
Alarms ' -
System * Subnet Mask: 255 255 2550
iDigi
Usars Default Gateway: 0.0.0.0
Position
N Enable autolP address assignment
Applications
ZZ;T;;“ * Changes to DHCP, IP address, and Subnet Mask may affect your browser connection.
Industrial Automation
Management
Serial Ports DHCP Server Settings

Connections
Event Logging
Metwork Services

MNetwork Services Settings
Dynamic DNS Update Settings

Administration IP Filtering Settings
File Management

#5809 Certificate/Key

r w w w w

IP Forwarding Settings

Management » IP HWetwork Failowver Settings
Backup/Restore S np—
Update Firmware REREL Tunnet settings
Factory Default Settings b Virtual Private Metwork (YPN) Settings
System Infarmation .
¥ » IP Pass-through Settings
Reboot
» Host List Settings
Logout

-

Yirtual Router Redundancy Protocol (YRRP) Settings

-

Advanced Network Settings

Figure 5: Ethernet IP Settings

2. Click the DHCP Server Settings link and open the DHCP Server Settings page.

3. Todisable the DHCP Server, un-check the "Enable Dynamic Host Configuration Protocol
(DHCP) Server" entry. Click Apply when finished.

4. Return to the Ethernet IP Settings page by clicking the Ethernet IP Settings link.

5. Configure the ConnectPort X4 with either a static IP address, or have it get its IP address
from a DHCP Server, whichever method is appropriate. Click Apply when finished.
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Viewing IP Address Information

The ConnectPort X4 Home page will display the IP address for both the Ethernet and Mobile networks.

ConnectPort X4 Configuration and Management

\Dig1
@ Help
Home Home
Configuration :
Network Getting Started
Maobile Tutorial Mot sure what to do next? This Tutorial can help.
XBee Network
Serial Ports System Summary
Camera
Alarms Model: ConnectPort X4
System Ethernet MAC Address: 00:40:90:50:12: 1A
iDigi
Use_rg Ethernet IP Address: 10.21.6.124
Position Mobile IP Address:  68.26.179.6
Applications
Python Description: None
RealPort Contact: None
Industrial Automation Lacation: None
Management
Serial Ports Device ID:  00000000-00000000-00409DFF-FF50121A
Connections

Event Logaging
Network Services

Administration
File Management

¥.509 Certificate/Key
Management

Backup/Restore

Update Firmware
Factory Default Settings
System Information
Reboot

Logout

Figure 6: ConnectPort X4 Home Page

Viewing Ethernet Statistics

To view information about the Ethernet Link as well as Ethernet and IP statistics, navigate to the
Administration > System Information > Network page.

The ConnectPort X4 is now ready to be moved to your Ethernet network, and by default will use its
mobile interface as its primary network interface.

Disconnect the ConnectPort X4 from your PC and then connect it to the Ethernet network (if the PC
needs to be reconfigured with a static IP address, do this prior to moving the PC to the Ethernet network
as well).

You have just completed Goal #1:
Configure the Wireless WAN interface of the
ConnectPort X4.
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Step 4: Setup the XBee Smart Plug and XBee Sensor

XBee/ZigBee Note: If you have additional XBee/ZigBee devices, for the best kit experience, we
recommend powering down or disable joining other XBee/ZigBee PANs in the area before
beginning this step. If you are unable to do this other devices might join the kit network and
create interference when deploying your iDigi Dia project. You could also encounter issues
connecting the XBee Sensor and XBee Smart Plug to the ConnectPort X4 as they are configured
to join any available PAN.

1. Remove the XBee Smart Plug from the box and plug it into a wall outlet. The green LED
will blink to indicate that the XBee Smart Plug is associated with an XBee network.

2. Remove the XBee Sensor from the box and insert the batteries (3) from the box and
install them into the XBee Sensor (unscrew the two screws on the XBee Sensor to install
the batteries). The XBee Sensor’s ASSC LED will blink when the device is connected to
your XBee network.

“i Note: If either of the XBee devices fails to blink its ASSC LED indicating that it is connected to

your XBee network, please refer to the “Is the ASSC LED solid green? ” section of Appendix D:
Troubleshooting on page 79 for more information.

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version
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Step 5: Connect the ConnectPort® X4 to iDigi®

The iDigi Cloud is an on-demand hosted service platform with no infrastructure requirements for the
user. The iDigi Cloud provides device management, iDigi client application to iDigi device data
interaction (messaging), and data storage for a network comprised of both wired and wireless Digi and
third-party Gateways (called iDigi devices). The iDigi Cloud provides easy integration with M2M and
mesh network devices.

First, before you can connect your ConnectPort X4 to iDigi, you must create an iDigi developer account.

1. To set up an iDigi developer account:

a. Navigate to http://www.idigi.com.

Login
b. Click the iDigi Login button in the upper right corner of the page.
c. Click the iDigi Developer Cloud login button.
r =
iDigi Device Cloud iDigi Developer Cloud

Hosted platform for device applications
Performance for transactional throughput

. iDigi's FREE development environment
-

e Scalahility for connected devices

.

-

Identical to the iDigi Device Cloud
iDigi APIs

Device and application integration
Getting started - training and kits

Reliahility for service availahility
Security for private information

[0 save my choice for faster login and to bypass this screen
“You can always "Reset Login ©ptions" at the bottomn of the website to restare this screen

Figure 7: iDigi Cloud Screen

You will be redirected to the iDigi Developer Cloud login page.

Want to learn more about iDigi?

Please refer to the iDigi User’s Guide which can
= be found at
http://www.digi.com/qgatewaydevelopmentkit

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version
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d. If you do not already have an iDigi developer account, click on the “Are you a new
user" link and create your account.
If you already have an account, login and skip ahead to the “Add the ConnectPort X4
to your iDigi inventory” section on the next page.

L‘j Dlgl' Developer Cloud

Log in to inigi
Are you 8 new user?
Usier Name:

Pagsword:

0L Gt LA QAT OF CARENGED

Figure 8: iDigi Login Page

Continue filling in all required fields of the iDigi Registration Form until you complete
the iDigi Registration process.

'\?Dlgl ® Developer Cloud

iDigi Registration

Company: N Address:

First Name: -

Last Name: * City:

Email: o State:

Job Title Postal Code

FIEIE Country: United States v

* Asterisk indicates required field.

Your privacy is important to us! We do not share your contact information with third parties. Privacy Palicy

_Nexi Cancel
Figure 9: New User Registration Page
e. After completing the iDigi Registration process, you will be redirected to the iDigi

Login page (refer to Figure 5, above). Enter your iDigi user credentials and then click
the Login button.

You have just completed Goal #2:
Creating an iDigi developer account on
the iDigi M2M operating platform.
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Add the ConnectPort X4° to your iDigi® Inventory
The iDigi Cloud allows you to securely manage the devices in your device inventory.
1. To add the ConnectPort X4 to your inventory, follow these steps:

a. Select the Devices link in the Left Navigation Bar.

b. Click the w Add Devices button in the Tool Bar to open the Add Devices
applet. The Add Devices applet will discover the Digi devices on your network.

Note: In order to discover devices on your network automatically, the Add Devices applet
requires Java Runtime Environment (JRE) 1.6 or newer.

If Java Runtime Environment (JRE) 1.6 is not installed, you must add your device manually;
see the “iDigi Manager Pro does not discover your ConnectPort X4” section of Appendix D:
Troubleshooting, on page 80 for more information.

c. Select your ConnectPort X4 from the list. To verify that you are selecting the
correct device from the list, match the MAC address listed on your label (found
on the bottom of the device) with the MAC address listed within the Add
Devices applet. Click the OK button.

Home Devices
Welcome -
Resources
Search ¥
» Management MAC Addrass Device |0 IP Address Device Type Deseription Status Firmuare Level
e o O04000:49B0BF  O0409dFF-FF4SbObT 10.21.6.178 ConnectPort X4 Gateway Dev Kit Damo Connected 21208
HHBee Metworks
Storage
Weh Serdces Consale AddDeices
Subscriptions
s Below are the devices found on your local network. Select the ones youwould like to add and click OK. If
urnrmary e i
¥ your device is not found, click the Add Manually button
Details
5 Administration 57 Afternpt to auto-configure selected discovered devices to connect to iDigi
Warning: This action may reboot the device.

hity Account
Messages

Select Devices: All Mone (7 devices found)
Operations

MAL Address IF Address Hardware Name Device Id & Refresh

004090 49B0BF 10.21 6178 ConnectPort X4 00408 0FF-FF49B0BF

Didn't find your device on the network?  Add Manually ==
N devices fo add
Ok Cancel
Ready 1 devices

Figure 10: Add Devices Applet

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version
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S
d. Wait about 60 seconds then go back to the Devices list and click the Refresh

button. The status of your ConnectPort X4 should now appear as “Connected.”

G :
¢ ] iDigi Manager Pro
'Dign

{r Home Devices
Welcome $ | By . + X | 1- &- | &

Devices ‘e 004000 SOBOBF DOS0GdFF-FFa@b0bT 10218178 ConnectPort X4 Gateway Dev Kit Demo Connecled 21200

»Bee Networks
Storage
Web Services Console

| Subscriptions

Summary
Details

{5 Administration

My Account
Messages
Operations

Ready

Bl
Resources .
Search: Q x ¥
“» Management MAC Address Device D IP Address Devioe Type Desoription Firmware Level

1 devices

Figure 11: iDigi Device Inventory

Note: If the device still appears as ‘Disconnected’ after clicking the Refresh button, please

refer to the “’iDigi Manager Pro lists the ConnectPort X4 as ‘Disconnected' section of
Appendix D: Troubleshooting, on page 82 for more information.

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version
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Step 6: Install the Digi ESP™ for Python Development
Environment

The Digi ESP for Python Development Environment is an Eclipse-based Integrated Development
Environment (IDE) that simplifies the process of creating Python applications for iDigi devices. It
also provides many example projects, one of which we will be using later in this section.

To download and install the Digi ESP for Python Development Environment:

1. Navigate to http.//www.digi.com/qatewaydevelopmentkit and click on the “Download
Digi ESP for Python” link.

2. You will be redirected to the Python Product page. The various download options for
the Digi ESP for Python framework will be displayed on this page. Click on the “Digi ESP
for Python - Windows XP/Vista/Windows 7 installer ver. 1.2.0.5” link to download the
Digi ESP for Python Development Environment.

Note: Mac operating systems are not supported in this Development Kit experience.

1 Maki Wirel M2M E contact us: @) phone (@) Email
Dian akin ireless as
8 Y | Search |-

Home * Suppart * Python

Drivers

Firmware Updates Product: Python Related Links
. Acti pp
- Product Status: Active e
Documentation - . . FTO Site
Support Status: Web, Email. Phone -
Diagnostics, Utilities and - Submlrftfe_:dback on our
= s
MiBs Eegister this product for warranty LR
Select = different product * RoHS compliance
Cabling
; » ~ = ; .
Knowledge base 877-912-3444 U.5. & Canada Submit 8 support ticket Knowledge Base
+ = = Waorldwid
Warranty registration L LR D il Search a database
of solutions, technical
Support forum articles and FAQ's

Service agreements ¢ Drivers
Return merchandise + Documentation
Online support request + Sample Applications

Manage Subscriptions

General Drivers:

How to install Digi ESP for Python Subscribe

Digi ESP for Python - Mac OS X (10.6) installer ver. 1.2.0.5 Subscribe
— EEL

< Digi ESP for Python - Windows XP/Vista/Windows 7 installer ver. 1‘2.0‘5> e

Subscribe

Digi ESP for Pvthon release notes

Privacy Policy | Terms & Conditions | Contact Us | Careers | Site Map | Newsletter Signup | Feedback

Copyright @ 1956-2010 Digi International Inc. Al rights reserved.

Figure 12: Select Digi ESP for Python Download Variant
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3. Once the Digi ESP for Python framework has been downloaded, run the Digi ESP for
Python framework installation wizard. Follow the steps in the wizard to complete the
installation process. Click Finish at the end of the installation.

Note: A prompt will ask you if you would like to open the Release Notes associated with
the Digi ESP for Python framework, deselect this checkbox.

4. The Digi ESP for Python framework will launch automatically and prompt you to select a
workspace directory. Use the default workspace directory (or click the Browse button
and navigate to your desired alternate workspace location), check the “Use this as the
default and do not ask again” box, and click OK.

Note: The Digi ESP for Python framework 'workspace' is the directory where projects and
configurations will be stored. The default location for this directory is a subfolder called
_ workspace on the user home directory, for example, C:/Documents and
= Settings/[username]/workspace.

) Workspace Launcher

Select a workspace

Cigi ESP for Python stores your projects in a folder called a workspace,
Choose a warkspace Folder ko use Faor this session,

Workspace: | C\Documents and Setkingstileezworkspace v| [ Browse, .,

Iz& this a5 the defaulk and do not ask again

K l [ Cancel

Figure 13: Selecting your Digi ESP for Python Workspace
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5. The first time you run Digi ESP for Python the Welcome screen is displayed.

File Edt Navigate Search Project Device Options Run  Package Manager ‘Window Help
@& wekome £3

Welcome to Digi ESP for Python

’ _/
e

Workbench
Go to the workbench

A} =

Figure 14: Digi ESP for Python Welcome Screen

6. Open the Digi ESP for Python Workbench by clicking on the Workbench icon (as

indicated above).

File Edit Mavigate Search Project Device Options Run  Package Manager ‘Window Help

Aw Rl i @-E-BR- i@ BE i@ B-0- IR0

=@

[% Pydev Package Expl &1 |

= O 5% oudine 52 |

ER-IF=T-1F e

An outling is not available.

El console 2 =] Properties] Ei Prob\ems] '&: Tasksw @ Terminaq

4B r3--18

Mo cansoles to display at this time.

P 0 0 items selected

(a0 @v =<

Figure 15: Digi ESP for Python Workbench
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Step 7: Create your first iDigi® Dia Project

The iDigi Dia (Device Integration Application) is software written in Python that simplifies the
task of gathering data from attached devices (such as XBee Sensors), and sending the gathered
data to iDigi, allowing for easy integration with client applications using the iDigi Web Services
API to access it.

The steps in this section will help you build, download, and launch your first iDigi Dia application.
The resulting iDigi Dia application will contain drivers for the XBee Sensor and XBee Smart Plug.
The application will also be configured to report its data using the RCI presentation for access

with iDigi Web Services (which will be demonstrated later in this guide).

To begin creating your first iDigi Dia project:

1. Open the iDigi Dia Project Wizard by clicking File > New > iDigi Dia Project from the File
menu.

AlL+Shift+r # @ Digi Python Application Project
Open File. .. @ Digi Python Application Sample Project
‘E‘ iDigi Dia Sample Project

S iDigi Dia Project

™ Project. ..

Figure 16: Selecting an iDigi Dia Sample Project
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2. The main wizard page contains a text box to insert the name of the project to be
created; name your project. This example uses a project name of “Demo_Project1” but
you can choose any unique name. Once the project name has been provided, click Next.

(89 iDigi Dia Project Wizard

Project name and location

Select the new project name and location

d |_Broject name: | DemD_Prnw) |

Use default location

| Erowse, ..
iDigi Dia setkings
Idse default iDigi Dia wersion
Seleck an iDigi Dia wersion:
iDigi Dia Path: Browse ...

Advanced project settings

Idse default configuration File name

[ ]Include iDigi Dia source code in project

@

Figure 17: Name your iDigi Dia Project
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3. Within the Remote Device selection wizard page ensure that Use Current Remote

Configuration is selected, and then click the New... button to create a new remote
configuration.

& iDigi Dia Project Wizard

Remote Device selection

Select the Remote Device Faor your iDigi Dia project

Remate Device
'@} Use Current Remote Device

() Select Specific Remote Device

Remote Device name: ConnectPork_X4

® < Back ” Mext =

Figure 18: Create New Configuration

A new Remote Device Configuration is needed to work with each specific target device

(your ConnectPort X4 in this case). Multiple remote configurations can be created for
working with different devices.
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a. After clicking the New... button, the Device Manager wizard dialog will open.

&) Device Manager

Configure a remote target and set it as the current configuration

Device Manager allows the creation of configurations For different remote devices and associates each configuration with a symbalic name

£ o —1
& - e | | The parameters for the communication between the IDE and the remote device can be easily (rejconfigured using this
P : dialog.
o Digi Device Additionally, the Device Manager allows the verification of communication betwesn the hast and the selscted targst

device (current configuration),

Configure Remate configuration settings from this dialog:

| | -Press the 'Mew' button to create a configuration of the selected bype

=| -Press the 'Duplicate’ button to copy the selected configuration

3 -Press the 'Delete’ butkon ko remove the selected configuration
|—=| -Press the 'Collapse All' button to collapse all the expanded remate configurations
@) -Press the 'Device Discovery' butkon to discover connected Digi devices.

-Edit ar view an existing configuration by selecting it

)

Close

ra,
(=
.

Figure 19: Device Manager Home Page
Note: The left side of the dialog lists the Remote Configurations that exist in the Workbench.

b. Initially, there are no Remote Configurations listed in the Device Manager. To begin
the process of creating your first Remote Configuration, enable the Device Manager
to discover the ConnectPort X4 automatically by clicking the Device Discovery &)
button.

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version

25



c. Adialog will ask you to identify a location where the Digi ESP for Python framework
should look for devices. Select Local area network/USB devices and click OK.

&) Device Discovery

=

(%) Local area netwark | USE devices,

Where do wou want to look For connected devices?

{7 Configured iDigi account.

Ik l [ Cancel

Figure 20: Digi Device Discovery Search Location Selection

d. When finished, the Digi Device Discovery dialog will appear listing all the Digi
devices discovered on your local network. Your device should be listed within the
dialog table.

e. Click on your device to select it from the list, and then click the Create Configuration
button.

igi Device Discovery

Digi Device Discovery >
Digi Device Discovery ool allows ta look For Digi devices connected ko your LAN or PC and register them in iDigi. %

Details & o
"No Device Selected i [P Address MAC Address Tame Device Device ID |
| 10.21.6.178 00:40:90:49:60:6F ConnectPaort k4 0o000000-00000000-0... |
| iDigi

‘fou can register a Digi device inko an iDigi
account From this dialog.

1 devices found

ion Close

Figure 21: Digi Device Discovery Applet
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The new configuration will receive a generic name, “ConnectPort X4” in this case, with
all the settings configured automatically.

f. Click Set Current to make this configuration the current one, which means that the
Digi ESP for Python framework will use it to perform several operations that require
interaction with the remote device (reboot, transfer files, etc.).

evice Manager

Configure a remote target and set it as the current configuration —
1
Device Manager allows the creation of confiqurations For different remote devices and associates each configuration with a symbalic Lyl
name Iy
@) = Mame: | ConnectPork =24 |
= * Digi Device — -
* ConnectPart %4 (current) General . LF LAN Connection | “fpy iDigi Connection
Select the connected device type From the lisk: iCDnnectPurt wd - |
Connection Mode
(®) Connect to device using local area network, | USE,
() Connect to device using iDigi PlatForm,
Yalidate Connection on Apply ‘Walidate Connection
=
? Set Current l [ Close

Figure 22: Device Manager
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4. After clicking the Set Current button you will be redirected back to the iDigi Dia Project
wizard. Ensure that Use Current Remote Device is selected, and click Next.

&) iDigi Dia Project Wizard

Remote Device selection

Select the Remaote Device For yvour iDigi Dia projeck

Remote Device
{f} Idse Current Remoke Device

() Select Specific Remoke Device

®

Remote Device name: ConnectPort_X4

@ < Back, ][ Mext = Einish

Figure 23: Remote Device Selection
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5. Ensure that Python Interpreter version 2.4.3 is selected within the Python settings
section, and that iDigi Dia is supported then click Finish to create the project.

& iDigi Dia Project Wizard M=
=
Remote Device's Information .ﬂ [+ \" ]
Information about Remote Device and Python Interpreter ) J

Firrmwware Information

Yersion: 2.9.0.13
Description:

Python ¥ersion: 2.4
Debug Support: Yes

< iDigi Dia Support: Yes >
Min. iDigi Dia Yersion: 1.1.17

Release notes

Click "Refresh" button ko attempt to reload firmware information,

Python settings

[]override detected Pythan Interpreter

S IET >

@

Finish ] [ Zancel

Figure 24: Remote Device’s Information

Note: If a prompt appears asking you to set a secure password click no.
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6. Once the project is created the Smart Project Editor for iDigi Dia screen will be

displayed.
Fil= Edit Mavigate Search Project Device Options Run  Package Manager ‘window Help
a @ -E-80- HoREE IR IR R R R Y- (@)
: =k
[% pydev Package Ex 572 = E'J 2 dia.yml () Dia Weh Presentation 9 diayml 22 = O || 5= outine 52
= B |+ i ™ An outling is not available,
e =1 ¥ Smart Project Editor for iDigi Dia & @
= T& Demo_Projectl
[ custom_devices -
Elements Properties
2 custom_loggers
" Eati Define the devices, loggers and This category contains all the Elements
& cus omJ:ures?n aHons presentations For vour iDigi Dia project in configured in the YML file.
[ custom_services this section.
= resources - - To add a new one, click on "add..."
& Python 2.4.3 (CESPIPyt = < Devices buttan. - )
W | 3B vBee Device ! - Toremove an existing one, click on
47 dia.ym m L “Remove" button,
= 0ggers ) - To change their order, click on "Move
= # Presentations Lp" and "Move Down” butkons,
@ RCI Handler [
38 Digi DE [idioi_
Console [cong
@R web [weh]
Services
< >
Graphic Editor | Source
E] cansale | = Praperties | [2 Problems | 4% Tasks | & Terminal @ Pragress | 25 Project] Conscle | E5 Projectl CLI &2
&
Telnet: (10.21.6,175:4146 - CONMECTED) |£| % \’JE = Q& ]: )
Welcome to the iligi Dewvice Integration Application CLI.
e |
£ >
o~ T Demo_Project!
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Figure 25: Smart Project Editor for iDigi Dia Screen

The created project is displayed in the

% Pwdev Package Ex 7

Pydev Package Explorer view; expand it to =
see its contents. To open the Pydev i IR i 5 =

Package Explorer view, select Window >
Show View > Pydev Package Explorer. If

= IE De

[ custom_devices

mao_Projectl

Pydev Package Explorer does not appear in
the list, select Other to open the Show
View dialog.

Note: Depending on your screen’s
resolution, it may be helpful to maximize
the Digi ESP for Python Screen.

[CaR AR AR

[+

# custom_loggers

= custom_presentations
(= cuskom_services

= resources

29 dia.vml

Figure 26: Pydev Package Explorer

= Python 2.4.3 (C\ESPYPyLE
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b. The main file of the project, dia.yml, will be opened and displayed in the Smart
Project Editor view. It contains the iDigi Dia elements (devices, services, etc.)
that will be used by the iDigi Dia project.

09 dia,yrl &3 =
% Smart Project Editor for iDigi Dia Wy

Elements Properties
Define the devices, loggers and presentations For vour iDigi Dia project in this This category conkains all the Elements
seckion, configured in the ¥ML File.

=4 Devices - To add a new one, click on "add..." buktan,

HB ¥Bee Device Manager [xbee_device_manager] i To Lemove-an existing ane, click an
@ Lraass Remowve" button,
i 9d . - To change their order, click on "Move Up"
[=l-#% Presentations and "Move Down" buttons,

@ RCI Handler [rei]

38 iDigi DB [idigi_db]

E Cansale [consoled]

&R web [webn]
Services

Graphic Editar | Source
Figure 27: Smart Project Editor View
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7. The XBee Sensor and XBee Smart Plug need to be added to your project via the iDigi Dia
Project Editor. To add these items, perform the following steps:

o

Click the Add... button to begin adding your XBee devices.
b. Forthe XBee Senor, select “XBee Sensor” from the Devices category, then click
the Add button.

Repeat this process for the XBee Smart Plug by selecting “XBee RPM” from the
Devices category and then clicking the Add button.

& Note: For non-US kits, select the “XBee Wall Router” instead of XBee RPM.

8. At this point in time the two XBee devices have been added to your project, but the iDigi

Dia Project Editor is missing the XBee MAC addresses for your XBee Sensor, and XBee
Smart Plug.

R “diayml

@ Smart Project Editor for iDigi Dia 'MacC address’ is

Elements

ﬁ RCI Handler [rei]
3B iDegs DB [sdegi_dib]
B Console [consolel]
@ Web fwebl]

g Services

Gaaphic Editer | Seurce

Define the devices, loggers and presentations for your iDigi Dia prapect in this

section.
i Deaces Add _
MR XBee Device Manager [shee_device_manager]
a1 xBee Sersor [senson] Remeave
il XBee RPM [rpmil]
| Loggers .
i_v‘. Presentateons Move Up

a required setting, please fil it "8 & Bk

Properties
et the properties of the selected element. Requered felds sre dencted by ="
devicesabeeabee_devioesabee_rpm:XBecRPM
rpmi)

L El'll""h'.' gEvice degonglion

Settings

%ot the settings of the selected element. Required fields are dencted by ™.

shee device_manager

1000
& 0On OfFf

Figure 28: Missing MAC Addresses

The XBee MAC address information for your XBee devices can be determined by
connecting to the web Ul of the ConnectPort X4.

Note: If you already know the IP address of your ConnectPort X4 Gateway open a web
browser and type in the IP address, and move onto Step 12. Otherwise, use the Digi Device

\g Discovery tool (described in the next step).
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9. Run the Digi Device Discovery Tool from your PC's Start Menu.

G Digi ) Digi¥3 Dashboard ¥

@) g

4 rﬁ, Digi Device Discovery  k ':_;r___ Digi Device Discovery

[E] Release Motes

Figure 29: Device Discovery Path

10. Running the Digi Device Discovery Tool will bring up the Digi Device Discovery
Application Devices list.

N

= BX

4+ Digi Device Discovery

IP Address = MAC Address Mame Drvice
Device Tasks el g 0k 40:90:49:B0:6F ConmectPork X4
Open wab interface

Telnet bo command line

Configure network settings

Bleshart devica

Other Tasks

Refresh view

Halp and Support

Details

ConnectPort X4
Configured (DHCP)

P address: 10,21.6.178
Subnet mask: 255,255, 255.0
Default gateway: 10.21.6.1
Serial parks: 1

Firmwears: B2001536_H1

My Device Network

Figure 30: Locate your Device in the Device List

11. Locate your device in the list and double-click on it to bring up the ConnectPort X4
Home page.
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IJ iDigi Gateway Develapment Kit I_] ConnectPort ¥4 Configuration an... @

D ConnectPort X4 Configuration and Management
O

@ Help
Home Home

Configuration
Getting Started
Metwork 2
XBee Metwork Tutorial Mot sure what to do next? This Tutorial can help.
Serial Ports
Camera System Summary
Alarms
System Model: ConnectPort x4
iDigi Ethernet MaC address: 00:40:90:49:B0:BF
Security
Position Ethernet IP Address:  10.21.6.178
Applications
Python Description: MHone
RealPort Contact: Hone
Industrial Automation Location: Hone
Management .
Serial Ports Device [D: 00000000-00000000-004090FF-FF40B0EF
Connections

Event Logging
Metwork Services

Administration
File Management

Dane

Figure 31: ConnectPort X4 Configuration and Management Home Page

12. The ConnectPort X4’s Home page contains several links. Click on the XBee Network link
from the left menu to access the XBee Configuration page.

Home

Configuration
MNetwork

| XBee Network |
Sernal Ports
Camera
Alarms
System
iDigi
Security
Position

Figure 32: XBee Network Option
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13. The XBee Configuration page shows the network view of the XBee devices attached to
the ConnectPort X4. Verify that your XBee L/T Sensor, ConnectPort X4, and XBee Smart
Plug are all listed (as shown below).

XBee Configuration

w XBee Devices

Gateway Device Details

PAM ID:  0Ox9c55 - OxB4ee87bead49e1a3
Channel: 0x17 (2465 MHz)
Gateway Address: 00:13:a2:00:40:47:26:0al
Gateway Firmware: 0x2170

MNetwork Wiew of the XBee Devices

Select a device to configure:

Mode ID «  Network Address  Extended Address Mode Type  Product Type
[og2d]! [00:13:32:00:40:30:e3:21!| end device  ¥Bee /L/T Adapter
[Dooo]! 00:13:a2:00:40:47:86:0al coordinator %4 Gateway
[bazd]l [00:13:52:00:40:60:3:061 | router Smart Plug

1 coordinator, 1 router, 1 end device

[ Discover XBee Dewvices l

] clear list before discovery

b Gateway Firmware Update
b OTA Firmware Update Setup
b OTA Firmware Update Status

Figure 33: XBee Network View

If your XBee L/T Sensor, ConnectPort X4, and/or XBee Smart Plug are not listed, try
clicking the Discover XBee Devices button to force the ConnectPort X4 to discover its
attached XBee devices.

r; If this does not fix the problem, see the “XBee devices fail to join the ConnectPort X4's
XBee network” section of Appendix D: Troubleshooting on page 79 for more
information.

You have just completed Goal #3:
Setting up and configuring the physical
elements of an XBee wireless network, and
understanding how the network is managed
through a ConnectPort X4 gateway.
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14. Now you need to configure the Smart Project Editor with the MAC addresses of the two
XBee devices that were added to this project in Step 7 (above). To do that, simply copy
the XBee Extended Address from the ConnectPort X4's web Ul (as shown in Figure 30)
into the appropriate MAC address field within the Smart Project Editor.

a. Copy the Extended Address of your XBee /L/T Sensor from the ConnectPort X4's
web Ul into the MAC address field of the XBee Sensor device in the Smart
Project Editor.

b. Then copy the Extended Address of your XBee Smart Plug from the ConnectPort
X4's web Ul into the MAC address field of the XBee RPM device in the Smart
Project Editor (as shown below).

%7 dia.yml 3 =0
i Smart Project Editor for iDigi Dia &y @D
Elements Properties
Define the devices, loggers and presentations for your iDigi Dia project in this section. Set the properties of the selected element. Required fields are denoted by "*".
- Devices Criver:  devices.xbee.xbee_devices,xbee_rpm:xEeeRPM
X8 ¥Bee Device Manager [xbee_device_manager] Hame™*: | ypemn
1‘,ﬂ ¥Bee Sensor [sensor0] [00:13:a2:00:40:30:e3:e11]
-JJ)i ¥Bee RPM [rpm0] [00:13:a2:00:40:60:F3:e61] @ show device descripkion
[ Loggers
Move Lip
= 3 Presentations Settings

ﬁi RCI Handler [rci]
38 iDigi DE [idigi_db]
E Console [console0]

Set the setkings of the selected element. Required fields are denoted by ",

e P —— #Bes Device Manager™: vhee device manager
Services I MAC Address™: 00: 13:42:00:40:60:F3:66
Sample rate: 1000
Dief ault state: ®on () Off
IDLE OFf seconds: 0

Paower On source:
Power Fackor adjustment: | ¢

Dievice profile: “

Graphic Editor | Source

Figure 34: Enter MAC Address
A Note: For non-US kits, select the “XBee Wall Router [xbr0]” instead of XBee RPM.
With the MAC addresses updated in the Smart Project Editor, all configuration errors

(missing XBee MAC addresses for your XBee Sensor and XBee Smart Plug) should be
cleared.
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Note: The XBee Sensor's default sleep interval is one minute. Changing the Sample Rate
configuration value to 5000 will set the sleep interval to five seconds, which will provide
sensor updates more often. These sensor updates will allow you to see value changes
more easily in the steps to follow. However, changing the sleep interval will impact

< battery life as well. This is something you should take into consideration when deploying
your devices.
15. Change the Sample Rate parameter of the XBee Sensor from 60000 to 5000 (as shown
below).
04 *dia,yml £3 =B
i Smart Project Editor for iDigi Dia €4 @
Elements Properties
Define the devices, loggers and presentations For your iDigi Dia project in Set the properties of the selected element. Required fields are denoted by
this section. -
=@ Devices Driver:  devices.xbee.xbee_devices,xbee_sensor:xBeeSensar

F& ¥Bes Device Manager [xbes_device_manager” Mame™: | sansorD
]| %Bee Sensar [sensorn] [00:13:82:00:40:30;e7] |__REMave
ﬂa XBee RPM [rpm0] [O00:13:a82:00:40:60:f3 ;6

@ Loggers
—

& show device description

Mowve Up

=-#% Presentations Settings

B RcT Handler [rci] Mave Down Set the settings of the selected element, Required fields are denated by

& iDigi DE: [idigi_db] CER

Console [console0]

Qv Web [web0] ¥Bee Device Manager*: xbee_device_manager

o . ! |
Services

MAC Address™: 00: 13:52:00:40:30:31211
Sleep: () True ) False
Sample rate*; En00|
Trace: ®on ) off
Amake time: 1000
Sample pre-delay: 125
Force humidity presence: () True (¥ False

Graphic Editor | Source

Figure 35: Change Sleep Interval Sample Rate
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16. Save your project by clicking the Save button from the main toolbar, or navigating to
File > Save from the menu.

File Edit _Mavigate Search Project Device Opkions Run  Package Manager indow Help

C - @-2-8R- B Bx G W %

N Figure 36: Save Project

17. Now that the XBee MAC addresses have been configured your iDigi Dia project is fully
configured and ready to be deployed. Click the Run ° button (on the main toolbar)
then select the Remote iDigi Dia option, and click OK to continue.

':Ef} Run As

Select a way to run 'dia. vl

L8 pydev: Google App Run

L niRemate iDigi Dia

Descripkion
Descripkion nok available

@ Ok ] [ Cancel

Figure 37: Launch your Project
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the:

iDigi Dia project builds,

Downloads files to your ConnectPort X4,
Reboots your ConnectPort X4 (in order to start the Dia application),
and finally starts running the Dia application on your ConnectPort X4.

The Source View at the bottom of the Workbench screen will display status messages as

Fie Edt HNavigote Search Project Device Opticns Run Package Monager Window Help

o m @ o-8 - B- B i @ -0 4 €08 =il
2 Pydev Package Bxpl £ = B pr—— = [ ot =
=h- WL BCE - Y T b tEd i e pukhes B8 ot svadabls,
= — = i smart Projec itor for IDigi Dia i
= U Demo_Projectl v L g v OO
B custoon_devices
&g = Efements Properties
3 (2 custom _presentations Deefine the devices, logoess and presentations fof your Set the propertes of the selected element, Requirad
& L‘.“' s D D prcipesct in bhis sescticn. Fields are dencted by "%,
:!_ Li; & B J Devices Ceiver:  dervices.abes.xbes_devices. sber_sercorn e
W gy BB sBee Device Mansger [rhe Mame™ | cpcenrll
B bk 21 #mee Sensor [sersord] [0 | Remove |
® = buid 43 ¥Bes FPM [rped] [00:13:8 @ Shoi dvios descriotion
= resouroes |25 Loggees Move Lo
G (= wrel_plenenits = & Prasectstions seip )
% ™ pthon 24,3 (CHESPyth) 8B T Herder [ro] Gath
7 dapy 18 v 08 [y _b) o
4 dia.ymd B Consote [conscieq] Hhm&hmm.ﬂmﬁm
- MBse Device Meriager®: [ hee dévice_manager
MALC Addrase®: ﬁ):lﬁ:d‘:lm:ﬂ:'iﬂ:ei::ll
Seep (% Trie I Fake
Sanpds rate™ ) SO0
4 ¥ Trace ®on Cokf
Graphic Editor | Source
& console "imt_m Z Tasks | 9 Termnadl | Progress | ) Dema Projoct Console 13 =
==ttt bevd ittt S et ] Bl Bl n P i L Wt L] e e d
[Teinek: (10,21.6.178:23 - CONNECTED) HikhDdDEES - B- %
;‘Care: post-asttings garbages collaction of 10 objects. -
|Stacting Scheduler. ..
|Starcing Channel Manager...
Srarting Device Driver Nanager...
}K!e:ﬁ:vi:e!unuge:1xh==_dev1c¢_mn.ug=r] : ceteleving node list
»{
) L
G Toinet! (10,21.6.178:23 - CONNECTED) Launching Demo_Project1: (100%) =@ || < ) (@ ® =]
Figure 38: Workbench Source View

Note: This process takes a minute or so, please be patient.
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18. The workbench will now display an additional tab, the Dia Web Presentation tab, and

your screen will look similar to the following:

e €0 Hovgeie Search Broject Device Gpbons En Eachogs Manager Wndow Lo

s i (B8P B- B % @ #-0- 483 m | &
I8 pydey Padiage Bl 12 O || R0 iy () Din Wb Prasertation © | o5 Outlna 1
AR o B | hepelf10.21.6.1780d_da bl | e R § 0 Mook avallable
- (=} .
B E_;":;;n'i(:wﬁ Web Configuration
# L custom_joggerns Manage channels
L _‘“cm—-\pescrl&m
* -:ﬂﬂm-ﬂmﬂ Apply Channel Timestamp
i - G b
W e remo
Arign current  2010-12-14 09:37:14
= resouroes light 2010-12-14 09:37:14 1
# 1= el _eleerenits E 4P r o
-0 Prthon 243 1CHEFYE | power_on 2010-12-14 09:37:05
B gy temperature 2010-12-14 09:37:14
T daymd
B make.py sensond
light None
low_battery None
temperature None
Apply Changes |
€ »
) Console | 1 Propertsss | (2 Problesss | 2] Tasks | 4 Termnal |12 Progeess | & Demo_Prajectt Console | &) Demo_Projectt Ll £ 5
Tedne: (10,21,6.176:4 146 - CONMECTED) FLI S =l 2 i B -
Velcome to the ibigi DBevice Integration Application CLI.
el
¢ ¥
- - ® B
Figure 39: Dia Web Presentation Tab
The Elements section of the Smart Project Editor for iDigi Dia provides several
presentations including an RCI Handler, Console Port, and a Web Presentation. For more
§ information on these items, refer to the “Digi ESP for Python” section of Part 2: Learn
.H' More, on page Error! Bookmark not defined..
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19. After the iDigi Dia project (created throughout “Step 5: Create your first iDigi Dia
Project” of this guide) starts running on your ConnectPort X4, you can interact with the
XBee devices by accessing the /idigi_dia.html web page directly from the web Ul of the
ConnectPort X4.

To interact with the new web page, open your web browser and enter the IP address of
your ConnectPort X4, followed by the “/idigi_dia.html” page (as demonstrated below
using the example “http://10.21.6.178/idigi dia.html”).

) Dia Web Presentation - Mozilla Firefox

File Edit Wew History Bookmarks Tools Help
@ - Gar LT hepefiin.21.6.1 78 idigi_dia html 77 - | 29~ »

|_“] Dia Web Presentation + -

Web Configuration

Manage channels
Apply Channel Timestamp Value Units
rpmo
current 2010-12-13 13:57:36 0 &
light 2010-12-13 13:57:36 140 7A2403343110 brightness
O power_on 2010-12-13 13:57:37 |On
temperature  2010-12-13 13:57:36 28.35 C
sensord
light 2010-12-13 13:57:32 563 brightness
low_battery MNone false
temperature 2010-12-13 13:57:32 21.67 C
‘

Done

Figure 40: XBee Smart Plug — Power ON

From this page you can turn the XBee Smart Plug off and on, as well as view all the
current sensor readings. In order to demonstrate how this web page can control the
power to a remote device, connect a lamp, fan, or some other electrical device to the
power outlet on the XBee Smart Plug.

a. Inthe example above, the XBee Smart Plug’s power_on state is currently turned
“On”. To turn the XBee Smart Plug off, simply replace the “On” with “Off” in the
Value column, then click the Apply Changes button.

b. The XBee Smart Plug will turn off, and the ConnectPort X4’s web page will be
updated to show the current power_on state of the XBee Smart Plug.
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) Dia Web Presentation - Mozilla Firefox

File Edit ‘“iew History Bookmarks Tools Help

O -c

| '] Dia Web Presentation + -

Web Configuration

far L hetpeii0.21.6.178jidigi_dia. bt v -] |28 »

Manage channels
Apply Channel Timestamp Value Units
rpmid
current 2010-12-1313:51.53 0.323 &
light 2010-12-13 13:51:53 51.31964809384164  brightness
O powWer_on 2010-12-1313:51:54 it
temperature 2010-12-13 13:51:53 25,96 C
sensord
light 2010-12-1313:51:50 549 brightness
low_battery MNone false
temperature  2010-12-13 13:51:50 21.67 C

Done

Figure 41: XBee Smart Plug — Power OFF

c. To turn the XBee Smart Plug on, simply type “On” in the Value field and click the
Apply Changes button.

d. To update the values displayed by the XBee devices’ sensors, click the Refresh
All button.

You have just completed Goal #4:

Using the Digi ESP for Python IDE to build,
download, and launch an iDigi Dia application for
your ConnectPort X4 gateway, and then interacting
with the application in a realistic setting.
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Step 8: Perform an iDigi Web Services API™ Request

The next step in the process of using your iDigi Gateway Development Kit is performing an iDigi Web
Services APl request using iDigi Manager Pro. The iDigi Web Services Console makes it easy to send web
service requests to your iDigi device. This example will demonstrate how to retrieve sensor readings
from your XBee Sensor and XBee Smart Plug by making a minor modification to one of the provided
examples, and then sending an HTTP Post request to iDigi, which will respond with the current sensor
readings from the sensors in your XBee devices.

The following steps will walk you through performing this APl request.

1. Login to your iDigi developer account.
2. Inthe Left Navigation Bar under the Management section, select the Web Services Console link.

fil Home

< SCl Targets 2] Examples = & Export~ b Send ¥ Clear

Welcome =

Path: Web Senvices Responses
Resources E——

hws/sci -

< Management HTTP Method: @ GET O POST (O PUT (O DELETE () HEAD

Devices S

your PCGST or PUT regquests

XBee Networks

Storage

Weh Senices Console
1| Subscriptions

Summary

Details Documentation
{& Administration

After selecting an example this pane will be filled with any documentation peraining to it.
Iy Account

Operations request.

results in greater detail.

Ready

About | Log Off

fTDlgIn iDigi Manager Pro idigi_test, iDigi Evaluation

IMessages The pane to the left contains the data that will be sentto the server along with a PUT or POST HTTP

The upper right pane will display any responses from the server, which you may click on to examine the

0 devices

Figure 42: Digi Manager Pro Web Services Console Page

3. Click on the SCI Targets button within the Web Services Console toolbar.

“ SC| Targets|i2) Examples = 2 Export P Send 3 Clear
Figure 43: SCI Targets Button
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4. Clicking this button will bring up the Select devices to be used in examples dialog box. Within
this box you will select the target iDigi devices that you would like to send requests to.

5. Click on the Add Targets drop-down box, and choose the device ID corresponding to your
ConnectPort X4. Click the Add button 4 244 and then click OK.

oy
iDigr

‘= Management

Wieb Services Consi

Subscriptions

summary
Details

&)

& Administration

4l Home ‘e SCITargets 2] Examples + 5 Ewport b Send 3 Clear
Welcome
Path ‘Weh Services Responses
Resaurces

iDigi Manager Pro

Select devices to be used in examples

Davices Add Targets: | ~| | 4 Add
HKBee Metworks 0 FF-FF43h0bi
Storage Device D Device Type  Status

n pertaining to it

My Account
MEssases with a PUT ar POST
Opetations
ou may click on to
¥ Remove Selected | ok |
Ready 1 devices

‘I Digr
£} Home

Welcame

‘@ SC| Targets

Fath

Figure 44: Add Targets

= Examples » =, Export =

iDigi Manager Pro

b Send ¥ Clear

Web Serices Responses

Resources

‘= Management
Devices
HBee Metworks
Storage
\Mieh Bervices Cong

Subscriptions

Summary
Details

&

{5 Administration
My Account
Messages
Operations

Select devices to be used in examples

Add Targets: 00000000-00000000-00409dFF-FF49h0bf

T

Device I | IP Address

| Device Type

 Status

004094 FF-FFagb0bt 10216178

¥ Remove Selected

ConnectPort X4

Connected

n peraining to it

with a PUT or POST

ou may click onto

Tok |

Ready

1 devices

Figure 45

: Targets Successfully Added
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6. iDigi Manager Pro will now send Web Services APl examples to the selected device. Within the
Web Services Console toolbar click on the Examples drop-down menu then go to SCI > Python
Callback.

< 5C| Targets |5 Examples ~ B Export = P Send 3 Clear

Path: CeviceCore »

hysisc Data » | -

Zached request

HTTP Kethod: (@
Uncached request
_ Find firmware targets
Disconnect device
Asynchronous 3
RCI 3

Figure 46: Python Callback
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7. Once you have selected the SCI Python Callback example, iDigi Manager Pro will populate the
page with the source code of the example as well as select the HTTP method that will be used
(an HTTP Post in this case). In order for you to retrieve the sensor readings from your XBee
devices, you will need to modify this example text slightly.

a.

Locate the following lines of text (highlighted in the screenshot below)
<do_command target="rci_callback example'>
ping
and replace them with the following:
<do_command target="idigi_dia'>
<channel_dump/>

Note: "idigi_dia" is the Target Name listed in the RCI Handler Presentation (as
mentioned on page 40).

’%lgr

£} Home
Welcome
Resources

“ Management
Devices
XBee Metwarks

Storage
Weh Services Console

11 Subscriptions
Summary
Details

@ Administration

Iy Account
lessages
Operations

Ready

About | Log Off
iDigi Manager Pro jlee, Digi

< SCI Targets 2 Examples v 2| Export~ b Send ¥ Clear

Path ‘Web Services Responses
fws/sci -

HTTP Wethod: (O GET @ POST (O PUT (O DELETE () HEAD

version="1.0">

Documentation

Example #1

This example will print out any data sent to it and then send the data back as the reply

t rei

xml
n "recieved:%s"ixml

rei zdd_rei_callback|"rei_callback_exarple", rei_callback)

Running this. send a RCI request as follows to the device

<rci remmest version="1 1">

ci_callback (xml): —

Figure 47: SCI Python Callback Example
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8. Your screen should look similar to the one below. Click the Send button to send this request to
iDigi. The first time you send a web services request to iDigi, you will be prompted to enter your
iDigi credentials, enter them in the dialog provided. Once authenticated, iDigi will send this
request to the ConnectPort X4 on behalf of your web services request and display the response
from the ConnectPort X4 in the Web Services Responses panel.

ﬁDIgI“

{ut Home
Welcome
Resources

‘e Management
Devices
XBee Metworks
Storage
Web Senices Console

711 Subscriptions
Summary
Details

@ Administration
Iy Account
Messages
Operations

Ready

About | Log Off
iDigi Manager Pro jlee, Digi

e SCI Targets 42 Examples + =, Export » w Clear
Path: Web Services Responses

fwsisc

HTTP Methaod: O)

4

Documentation

Example #1

This example will print out any data sent to it and then send the data back as the reply

def rei_callbackixml):
t xml
n "recieved:%s"ixml

rei_zdd rei_eallback("rei_callback_exarple”, rei_callback)

Running this. send a RCl request as follows to the device

=l | <rci recuest version="1.1">

Figure 48: Updated SCI Callback Example
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9. Observe the output displayed within the Web Services Responses panel. A "POST /ws/sci 200”
response indicates that the web services request was successful.

’ififblgr

2t Home

YWelcame
Resources

‘“ Management

Devices

HBee Metworks
Storage

Weh Services Consale

1.0 Subscriptions
Summary
Details

@ Administration

My Account
Messages
Operations

Ready

iDigi Manager Pro

-
dee
http://www. digi. com/ wiki/deve loper/
for
an example of & python
implementation on a NDE device to
handle this 2CI request
--r<scil_request version="1.0"x
<gend message>
<targets>
<device id="00000000-00000000-
00409dFF-FF49h0ht"/ >
</frargets:
<roci_regquest version="1.17»
<do_command target="idigi dia™s
<channe l_du.mp,-" >
</ do_commands
</roci_requestr
</send messager
/5ol requesty

<

< SC| Targets [2 Examples ~ & Export» b Send 3 Clear

HTTP Method: O GET @ POST O PUT O DELETE O =

ir

| ™

Pl SETYICRS RSO

POST hwsfsci 200 click o examine

Documentation

>

Example #1

This exarmple will print out any data sent to it and then send the data back
as the reply

import roi
def rei_callback {xml):
print uml

return "reciewved:$s"4xml

roi.add rei_callback('reoi_callback example', reoi_callback)

|

Figure 49: Successful Callback Attempt
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10. Click on the "POST /ws/sci 200” response text to view the entire response from the ConnectPort
X4, as well as the request that was sent to generate this response. The channel_dump response
shows the current usage, brightness, power-on state, and temperature readings from the rpmO
(XBee Smart Plug) device, and the brightness, battery condition, and temperature reading from
the sensor0 (XBee Sensor) device.

i Digr

{ar Home

iDigi Manager Pro

# SC1 Targets 2 Examples = =, Export b Send ¥ Clear

Welcome
Resources

»# Management

Devices
HBee Metworks
Storage
Weh Services Consolg

Subscriptions
Summary
Details

& Administration

by Account
Messages
Operations

Ready

POST fws/sci 200 ]
Response Reguest
1 reply version="1.0"> )]
2 nd_message>
idevice id="00000000-00000000-004090FF-FF49EOEF ">
4 «<rci_reply version="1.1">
5 <do_command target="idigi_ dia">
channel dumn
H, <devicg natme="rpmd ">
<channel nemwe="current" wvalue="0.328" units="A" timestamp="Mon Nov LE=
=} <channel newe="light" wvalue="363.636363636" units="brightness" timeft
10 <channel namwe="power on" value="0n'1 units="" timestamp="MNon Nowv 15 |3
3£ ! <channel nawe="temperature™ value="3I0,72" units="C" timestswp="Mon Hc
iz </ devices
13 <device name="sensorl":
14 <channel nawe="light" wvalue="639.0" units="brightness" timestamp="HNpr
15 <channel nawe="low hattery” value="False" units="" timestamp="Thu Jhr—
16 <hannel name="temperature” value=":2Z4,02" units="C" timestamp="Mon §c
17 </device>
1 </ channe 1 dumps
19 </do command: o]
zo@ — (T - i %
RN EE A s roi-add reoi callbacki'rei callback example',

About | Log

send the data back

rocil_callback)

Figure 50: Successful Callback Expanded View

You have just completed Goal #5:
Using the iDigi Manger Pro Web Services
Console to send a web services request to
the ConnectPort X4, retrieving the current
XBee devices’ sensor readings.
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Step 9: Using the iDigi® Gateway Development Kit Demonstration
Application

The final step in the process of taking advantage of what this Development Kit offers, is

accessing the iDigi Web Services API via the iDigi Gateway Development Kit Demonstration
Application. The following steps will walk you through this process.

1. Navigate to http.//www.digi.com/qatewaydevelopmentkit and click on the “Link to iDigi
Gateway Development Kit Demo Application” link.

2. You will be redirected to the iDigi Gateway Development Kit Demonstration Application
login page. Enter your iDigi username and password, as well as the last 6 characters of
your Gateway ID, into the appropriate fields and then click the Login button.

1@; iDigi Gateway Development Kit

Demonstration Application

iDigi Account Information

Are you a new user?
Username: |

Password:
“Gateway ID: |

* Only include last 6 digits of your Gateway ID

Copyright @ 1996-2010 Digi International Inc. All rights reserved.

Figure 51: iDigi Gateway Development Kit Demonstration Application Login Page
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After logging in, the demonstration application will display a screen similar to the following:

»1s]; iDigi Gateway Development Kit

Demonstration Application

Logout o Refresh (¥

XBEE SENSOR '

-—
-— 214C
™
o o 10 3 30
LIGHT TEMPERATURE 0 40
595.0 bk:lg]'éniass 2k
0.7,
CURRENT
0.7 A

LOGGED DATA

-2EEEE

Brightnass Celsius

B xBae Senscr [l XBea Smart Plug B xBae Sensor [l XBea Smart Plug Il XBos Smart Plug

Copyright @ 1996-2010 Digi International Inc, All rights reserved,
Figure 52: iDigi Gateway Development Kit Demo Application
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Getting Familiar with the iDigi Gateway Development Kit Demonstration
Application

This demonstration application displays the current sensor readings and logged sensor readings
for the XBee Sensor and the XBee Smart Plug connected to your ConnectPort X4’s XBee
network. Values are updated by clicking the refresh button. Every time the screen is refreshed
the application also updates the time-stamp information at the top of the screen.

Logging begins automatically once you log in to the application, and logged data is collected

once a minute for 60 minutes. After the 60 samples are collected, logging stops. To collect more
samples, simply log out, and then log back in to the demonstration application.

XBee® Sensor:

The XBee Sensor has an internal light and temperature sensor. The last reported readings from
both internal sensors are reported.

—-— 586.0 brightness
s
LIGHT TEMPERATURE
596.0 brightness 214 C

Figure 53: XBee Sensor Display

In the event that your brightness reading looks similar to the example above, simply cover the
light sensor on the front of the XBee Sensor and click the Refresh button, and you should see
something similar to the following:

<A\

1.0 brig o
LIGHT TEMPERATURE

1.0 brightness Zz4ac

Figure 54: XBee Sensor Display Refreshed
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XBee Smart Plug ™ (for US kits only):

The XBee Smart Plug has an internal light and temperature sensor. It also has the ability to track
its current usage and allows the XBee Smart Plug to be turned on or off. This demonstration
application displays the current flowing through the XBee Smart Plug and the On/Off state of
the XBee Smart Plug.

(0]
Q 1.5

CURRENT b POWER

154

Figure 55: XBee Smart Plug Display - Current Flowing

In the event your XBee Smart Plug displays something similar to the output above, simply click
the “Off” button, and then click Refresh. Your XBee Smart Plug should display something similar
to the following:

XBEE SMART PLUG

; '
0.0 5 10
CURRENT POWER b
o

0.0 A

Figure 56: XBee Smart Plug Display - No Current Flowing
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Logged Data:

The logged data area displays up to the last 60 sensor readings from all XBee device sensors.
Logging will stop automatically after an hour and data will be discarded after 24 hours. In order
to update the Telemetry data, click the Refresh button.

LOGGED DATA

Figure 57: Logged Data Display — Off

When you log in to this demonstration application, Telemetry logging will start automatically
and run for an hour. Since the logged data is collected once every 60 seconds and only 60
samples are logged, you may need to wait up to 2 minutes before the Telemetry data is updated
(as shown in the example below).

LOGGED DATA

-EEEEER

o
Brightness: Calsius
B ¥Bee Sensor ] XBea Smart Plug I ¥Boe Sensor ] XBea Smart Plug Il XBoo Smart Plug

Figure 58: Logged Data Display — Begin Logging
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By turning off the XBee Smart Plug and covering the light sensor on the XBee Sensor, a
subsequent screen refresh should make the Telemetry data look similar to the following:

LOGGED DATA

Brightnass Colsius
I ¥Bee Sensor [l XBee Smart Plug I *Boe Sensor [l XBea Smart Plug I XBee Smart Piug

~EBEEEE
cu3 8BRS

Figure 59: Logged Data Display — XBee Smart Plug Off, XBee Sensor Covered

Waiting a few moments before turning the XBee back on, and uncovering the light sensor on the
XBee Sensor should make the Telemetry data look similar to the following:

LOGGED DATA

NGB8

T -

\/

Brightnass Calzius

-EHEEEEZ

B ¥Bew Sensor [ XBea Smart Plug B *Boe Sensor ] XBes Smart Plug [l ¥Bes Smart Piug

Figure 60: Logged Data Display — XBee Smart Plug On, XBee Sensor Uncovered
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By clicking on one of the gauges or graphs, the application will display a more detailed view as
shown below:

Figure 61: Graph Expanded View

You have just completed Goal #6:

Using the iDigi Gateway Development Kit
Demonstration Application to understand how a
web services enabled Enterprise application
interacts with iDigi and monitors the data
gathered by the XBee device’ sensors.

Congratulations you have completed the process of setting up your
iDigi Gateway Development Kit!

Please read through the “Part 2: Learn More” section of this guide to learn more about the Digi devices
and applications used throughout the process of setting up your iDigi Gateway Development Kit.
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Part 2: Learn More

iDigi® Dia & iDigi®

iﬁﬁnlgl The iDigi Cloud is a Machine to Machine (M2M) network operating
S e —9 platform, used by software developers and organizations responsible
\w’_f\\——/ Appleaions for supporting the network. It enables secure, reliable M2M delivery
N from your remote devices to your enterprise application.

Going to Market?

Many users of the iDigi Developer Cloud are creating M2M applications they intend to launch as
commercial applications. Taking advantage of the iDigi Production Cloud with unlimited
scalability, high-availability and industry leading security is easyas 1- 2 - 3.

1. Contact Digi Business Development and express your desire for an iDigi Production
Account at 1-877-IDIGI-EZ or by email at http://www.idigi.com/contactus/#email.

2. A Digi Business Development Representative will send you a copy of the iDigi Terms of
Service and review pricing.

3. Sign the Terms of Service and an iDigi production account will be created and log-in
credentials will be emailed to you.

Since iDigi is an on-demand platform as a service, you will only be charged for what you use.
Further support can be accessed through our support portal at:
http.//www.digi.com/support/?kw=idigi.

iDigi Dia (Device Integration Application) is software that simplifies
connecting devices (sensors, PLCs, etc.) to communication gateways.
Dia includes a comprehensive library of plug-ins that work out-of-the-
box with common device types and can also be extended to include
new devices. iDigi Dia's unique architecture allows the user to add
most of these new devices in under a day.

B iDigiDia
O

iDigi Dia is designed upon a tested architecture that provides the core functions of remote
device data acquisition, control, and presentation between devices and information platforms. It
collects data from any device that can communicate with a Digi gateway, and is supported over
any gateway physical interface. iDigi Dia presents this data to upstream applications in fully
customizable formats, significantly reducing a customer's time-to-market.

Written in the Python programming language for use on Digi devices, iDigi Dia may also be
executed on a PC for prototyping purposes when a suitable Python interpreter is installed.
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Further documentation on iDigi Dia and iDigi can be found within the iDigi Manager Pro
Resources link. Once logged in to iDigi Manager Pro, click on the Resources link in the Left
Navigation Bar and explore the documents listed under the “iDigi Dia Resources” and “iDigi
Cloud Resources” headings.

Resources
fat Home
Welcome
Resources
Resources
“» Management Support Forums
. Support Forums
Devices
XBee Networks iDigi Dia Resources
Install Digi ESP (Eclipse-based Development Environment for Python)
Storage Download iDigi Dia 1.3.8 | Read Me | Online Documentation | Download Documentation (zip file of online content)
Web Services Console
iDigi Platform Resources
iDigi User's Guide
| Subscriptions iDigi Web Services Programming Guide

Figure 62: iDigi Dia and iDigi Documentation

Additional documentation can also be found on the product specific section of the Digi website
http://www.digi.com/qgatewaydevelopmentkit, under the “Support Documentation” heading of the
Documentation tab.

Digi ESP™ for Python

Digi ESP for Python is an Integrated Development Environment (IDE)
that allows the developer to easily develop applications in Python. Digi
ESP for Python is built on Eclipse and the Python Development
Environment (Pydev) plug-in. Eclipse is an open, extensible IDE. It was
originally written for Java development. The Pydev is a plug-in that
provides support for developing applications with Python in the Eclipse
platform. Digi ESP for Python customizes Eclipse and PyDev to support
developing specifically with Digi platforms.

Digi ESP for Python documentation can be found within the Digi ESP for Python framework
program. To locate this documentation:

Navigate to the Digi ESP for Python Welcome page and click on the Overview button. Once the Python

overview screen is displayed, click on the “Digi ESP for Python” framework link and browse the
documentation contained within this page.

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version 58



Fit Edt Navigstn Seach Frowct DevioeGptons Run FacageMansgsr Widaw Help
B ks 1

Welcome to Digi ESP for Python
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Figure 63: Welcome Screen Overview Button
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Digi ESP for Python
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Figure 64: Digi ESP for Python Overview
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Additional help documentation can be located by navigating to Help > Help Contents from the Digi ESP
for Python framework main menu.

igiPython - Digi ESP for Pyt

File Edit

Mavigate Search Project

Device Options  Run Package Manager  wWindow Nyl

55 Help - Digi ESP for Python

& welcame £2

Welcome to Digi ESP for Python @ Search

| & welcome

Drvniamic Help

Key Assist, .. Crrl4Shift+L
Tips and Tricks. ..

Cheat sheets..,

Check for Updates
Install Mew Software..,

About Digi ESP For Python

Figure 65: Help Contents Path

Digi ESP
for Python
Contents & o | e el =
© Getting Started " -
™
R poe Using the Digi ESP™ for Python help system
e Package Manager Help &
" iDigi Dia Documentation Browse topics in the Contents frame () on the lsft. Click on a topic to have it displayed. Use the Back and Forward buttons to navigate within the
@ iDigi Client Applications history of viewed topics
[ % References )
@ dditional Help Searching
To quickly locate topics on a particular subject in the documentation, enter a query in the Search field Use the Search frame l%:-'}to display the Search
view. You can narrow the scope of your search by selecting only the sections you are interested in.
Synchronizing
Clicking the Show in Table of Contents button t'@'} will select that topic in the navigation tree. The Link with Contents button (4=T>] keeps the navigation
tree synchronized to the current topic
Capabilities
To show documentation about capabilities that are disabled in the application. select the Show All Topics button (@a} ‘When you choose to show all
topics in the table of contents, the headings for documentation about any disabled activities are shown in the table of contents and also appear in search
results.
More information
® Follow the instructions in Geffing Started. This guide will help on your first steps with Digi devices.
® Follow the full help documentation in Digi ESF™ for Python to get started with the workbench environment. This guide will help you create. build
and launch Digi Python Applications and iDigi Dia projects using the Digi ESP™ IDE.
ckage IManager Help explains how to maintain up to date your environment.
i Dia Documentafion contains iDigi Dia User Documentation.
B See also iDigi Dia api_reference folder at <DigiPython_path>\Dia\Dia_X.Y.Z\doc\api_reference\html.
All documentation is also available on our website. http:/fiwww.idigi.com.
@ BUILT ON
iDign o @
B [ & %

Figure 66: Digi ESP for Python Help Section
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The Elements section of the Smart Project Editor for iDigi Dia provides several presentations
including an RCI Handler, Console Port, and a Web Presentation. The Web Presentation (iDigi
Dia project) described in this guide provides details for a new web page “idigi_dia.html.” Click on
the Dia Web Presentation tab to open this new web page.

Eile Edit Mavigate Search Project Device Qptio

[£ Pydev Packsge e 22~ T O
25 E
= % Project1

&

&
&
&
&

]
©

[ custom_devices

(@ custom_loggers

(@ custom_presentations
(8 custom_services

(= build

(= resources

 Python 2.4.3 (CAESP\PYI
W dia.yml

9 dia.yml

s Run Packase Manager Wind‘w Help
() Dia Web Presentation

# Smart Project Editor for iDigi Dia

Elements

Define the devices, loggers and presentations For your igi Dia project in this section.

= Devices

2@ ¥Bes Device Manager [xbee_device_manager]

1| xBee Sensor [sensord] [00:13:82:00:40:62:a5:5d1]

ibﬂ XBee RPM [rpm0] [00:13:82:00:40:60:f3:261]

@ Loggers
=

=l #% Presentations

@ RCI Handler [rei]
32 iDigi DE [idigi_db]
B cansole [consalen]

Services

Graphic Editor | Source

] console | = Praperties |21 Prablems
Telnet: (10.21.6.178:23 - COMNECTED)

EZBeelensor (sensord) @
XBeeSensor [sensorl) :
EBeelensor (sensor0)
EZBeeSensor (sensord) @
YBeeSensor [(sensor) :
EZBeelensor (sensord) @
XBeeSensor [sensorl) :
EBeelensor (sensor0)
EZBeeSensor (sensord) @
¥BeeSensor [sensorl) :
EZBeelensor (sensord) @
XBeeSensor [sensorl) :
EBeelensor (sensor0)
EZBeeSensor (sensord) @
¥BeeSensor [sensorl) :

21
21
21
21
21
21
21
21
21
21
21
21
21
21
21

C,
C,
C,
C,
C,
C,
C,
C,
C,
C,
C,
C,
C,
C,
C,

&) Tasks | & Terminal 1 € Progress [ project1 Console E2 . EF Project1 CLI

brightness
brightness
brightness
brightness
brightness
brightness
brightness
brightness
brightness
brightness
brightness
568 brightness
626 hrightness
£33 hrightness
619 brightness

P T R TN O P I I

=

=

Properties

Set the properties of the selected element. Required fields are denoted by "+,

Driver;  presentations, web, web:Web

Mame*: | webn

@ show presentation description

Settings

Set the settings of the selected element, Required fields are denoted by "+,

idigi_dia,html >

Port: a0t

Polling: o
O False

Use default server: (2) True

Title: Dia Web Presentation

ElER =L 1R

=4

@

BEex . T O
An outling is not
avwailable.

B-x =0
~

v

5@

The iDigi Dia project also provides support for a new Console Port (using TCP Port 4146 as

detailed below).

Figure 67: Dia Web Presentations
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89 diayml £2 & Dia Web Presentation =0

% Smart Project Editor for iDigi Dia By @
Elements Propetrties
Define the devices, loggers and presentations for your iDigi Dia project in this section. Set the properties of the selected element. Required fields are denoted by "+,

2P Devices - Cwiver:  presentations.console.consale: Console

2B ¥EBee Device Manager [xbee_device_manager] Mame™ | consolen

1) ¥Bee Sensor [sensord] [00:13:22:00:40:62:25:541]

B ¥Bee RPM [rom0] [00:13:42: 00:40:60:F3:261] & Show presentation description
k| Loggers
Move Up
= g Presentations Settings
?i RCI Hand‘\;‘ar.[l’dc‘ij] Set the settings of the selected element, Reguired fields are denobed by ™+,
1
E Type:!
@M web [weba] tep 3
{V}E Services Port: 4146
Serial device: fcom]0
Setial Baud Rate! [115200 -

Graphic Editor | Source

Figure 68: New Console Port

To use the new Console Port, establish a Telnet connection to your ConnectPort X4 using TCP
port 4146, and the iDigi Dia CLI will be presented to you.

Telnet 10.21.6.178

Welcome to the iDigi Device Integration Application CLI.
=>> 7

channel_set i logger_prev q

exit logger_list logger_rewind guit

help logger_next logger_seek
channel_refresh logger_dunp logger_ pos logger_set

=>» channel_dump

Device instance:
Channel i Timestamp
current B.297 A 2818-12-82 B6:46:28
light (2)1 .1143695815 brightne 2018-12-82 @6 :46:28

power_on n 2018-12-A1 14:83:22
temperature 26.51 2018-12-82 B6:46:208

Device instance: sensor8

Channel i Timestamp

brightne 2018-12-B2 Bh:46:17
low_hattery 1978-81-61 8@ :00:008
temperature [H 2018-12-82 B6:46:17

Figure 69: Establish a Telnet Connection

The “?” will provide a list of the supported CLI commands, and the “channel_dump” command
will retrieve the current sensor readings from your XBee devices’ sensors.
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Digi’s® Gateway Products

Digi’s ConnectPort X Family of programmable mesh
networking gateways provide two fundamental benefits:
gateway functionality and programmability.

Gateway Functionality

The gateways function, as the name implies, as gates between local mesh networks (e.g.
ZigBee) and IP-based networks (e.g. Cellular). The gateways support the following network
protocols:

® PAN Networks:
- ZigBee
- DigiMesh 2.4 GHz
- DigiMesh 900 MHz

e |P Networks:
— Ethernet
- WiFi
- 2G/3G/4G Cellular
- WiMax
- Satellite

Programmability

ConnectPort X Gateways support the Python programming language and offer the memory

space for local development. This allows the gateways to function with enough local

intelligence to make decisions about which events are worth communicating over the wide

area network. This is especially useful when sending traffic over proprietary cellular or
satellite networks.

iDigi Dia (described above) further enhances the value of custom programming on Digi
gateways by offering an expanding library of Python plug-ins to support and manage
communication between many common device types and iDigi.

For more information regarding ConnectPort X Gateways please go to:
http://www.digi.com/products/wireless-routers-gateways/routing-

gateways/connectportx4.jsp#overview
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XBee® Sensor

Digi XBee Sensors are compact, battery powered environmental sensors for
ZigBee networks. They provide real-time temperature and light information
for a variety of applications.

For more information regarding XBee Sensors please go to:
http://www.digi.com/products/wirelessdropinnetworking/sensors/xbee-sensors.jsp

XBee Smart Plug™ (or XBee® Wall Router in non-US kits)

The Digi XBee Smart Plug is an intelligent outlet that has the ability to
measure and control electrical devices plugged in via a standard electrical
outlet. The XBee Smart Plug and XBee Wall Router have integrated light and

temperature sensors. Both devices are XBee routers and extend the range of
a ZigBee Network.

For more information regarding the XBee Smart Plug go to:
http://www.digi.com/products/wirelessdropinnetworking/networkextenders/xbee-smart-plug-
zb.jsp

For more information regarding the XBee Wall Router go to:
http://www.digi.com/products/wireless/zigbee-mesh/xbee-wall-router.jsp

Digi’s® ZigBee RF Modules

The ConnectPort X4, XBee Sensor, and XBee Smart Plug/XBee Wall Router used in this kit each
contain a ZigBee RF module built on Digi’s XBee hardware platform. Utilizing the ZigBee wireless
standard, these modules are interoperable with other ZigBee devices, including devices from
other vendors. Programmable versions of the XBee-PRO ZB module make customizing ZigBee
applications easy, even without wireless design expertise.

If you are interested in learning more about Digi’s XBee and XBee-PRO ZB modules, we

encourage you to purchase a Digi ZigBee RF Module Development Kit from www.digi.com or
your Digi authorized reseller.
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Appendix A: Configuring for GSM/Edge Cellular Networks

This Appendix provides an overview of how to configure the Wireless WAN interface of the ConnectPort
X4 for GSM/Edge cellular networks for carriers like AT&T and T-Mobile.

This Appendix also describes how to view the ConnectPort X4 cellular connection status, and its IP
Gateway priority list.

Step 1: Inserting the SIM Card(s)

«— Primary
«—— Secondary

Figure 70: Inserting the SIM card
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Step 2: Configuring the Cellular Interface

1. Click on Configuration > Mobile from the left-hand menu.
2. The ConnectPort X4 has two SIM slots with Slot 1 being the primary SIM slot. If you wish

to use SIM Slot 2, use the SIM drop-down box to select “Slot 2”, and then click Set as
Primary.

Mobile Configuration

Select a SIM to configure from the list below.

Settings on this page apply to the selected SIM.

SIM: Slot 1 »

IMESI: 210410265385546
ICCID: 20014104232653855469
Phone Mumber: 19522212376

Status: Primary

Figure 71: Mobile Configuration

1. Configure the Mobile Service Provider Settings by entering the Service Provider, Service
Plan/APN, and Customer Plan Name appropriate for your environment as shown.

+ Mobile Settings

Select the service provider, service plan, and connection settings used in connecting to the mobile
network.

These settings are provided by and can be retrieved from the service provider.

Mabile Service Provider Settings

Service Provider: IAT&TICinguIarWireless (Blue Metwork) j

Service Plan / APN: ICustom APMN vl
Custom Plan Name: IIZGOLD

Maobile Connection Settings

¥ Re-establish connection when no data is received for a period of time.
Inactivity timeout: ISSDD seconds

Apply | Setto Defaults |

Figure 72: Mobile Settings

2. Click Apply when finished.
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Verifying the Cellular Connection Status

Once the correct cellular configuration has been applied, the ConnectPort X4 will begin to establish the
cellular connection. You can verify the connection status by navigating to the Administration > System
Information > Mobile page.

System Information

» General
b Serial
» Metwork
* Mobile

SIM Information

The following information and statistics can be used to manage and monitor your mobile connection. This information may
also be helpful in troubleshooting problems with the mobile network,

ICCID: A

Maohbile Connection

Mobile Statistics

Mobile Information

Registration Status:
Location Area Code:
Cell ID:

Signal Strenath:

IP Address:

Primary DNS Address:
Secondary DMS address:
Data Received:

Data Sent:

Idle Resets:
Inactivity Timer:

Slot IMSI and ICCID Phone Number  Status PIN Status  Active
1 310410263385546 195222123706 Primary Ready J
89014104232653855469
2 IMSI: MNf& RS Mot configured  MAA J

Registered (Home Network)
0xD6EF (55023)
Ox969E (38558)

I:IDDI:IH (-3a dem)

166.130.120.49
209.183.33.23
209.183.33.23
230222 bytes
42331 hytes

26

23600 seconds (receiving)
0 seconds {sending)

Figure 73: Verification

NOTE: In the above example, the ConnectPort X4 is connected to the cellular network and has
obtained the 166.130.120.49 address for its cellular interface.
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Appendix B: Configuring for CDMA Cellular Networks

This Appendix provides an overview of how to configure the Wireless WAN interface of the ConnectPort
X4 for CDMA cellular networks for carriers like Verizon and Sprint.

This Appendix also describes how to view the ConnectPort X4 cellular connection status, and its IP
Gateway priority list.

CDMA Cellular Configuration Example (Verizon)

NOTE: This example assumes that the ESN/MEID# for the ConnectPort X4 has been activated with
your cellular provider. You can find the ESN/MEID# on the bottom of your unit.

To configure a CDMA ConnectPort X4 cellular interface perform the following steps:

1. Click on Configuration > Mobile from the left-hand menu and select Verizon Wireless from
the Service Provider drop-down menu. You should see a screen similar to the following:

Mobile Configuration

¥ Mobile Settings

Select the service provider, service plan, and connection settings used in connecting to the mobile
network,

These settings are provided by and can be retrieved from the service provider.

Mobile Service Provider Settings

Service Provider: Yerizon YWireless v

Mohile IP mode: Mohile IP Preferred »

Caution: Modify the mobile IP mode only on the recommendation of your service prowvider.

This device needs to be provisioned: Prowision Device

Mobile Connection Settings

Re-establish connection when no data is received for a period of time.

Inactivity timeout: 3600 seconds

[ Apphy ” Set to Defaults

P GPS Settings
P Adwvanced Settings

P SureLink Settings

» Short Message Service (SMS) Settings

Figure 74: Mobile Configuration
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2. After selecting a Service Provider, the unit needs to go through its provisioning process. Click
the Provision Device button, and then follow the steps displayed within the Mobile Device
Provisioning dialog screens.

NOTE: The default options within the Mobile Device Provisioning dialog screens will be
correct for most installations.

3. When the following screen is displayed, select the Automatically provision the mobile
device option.

) ConnectPort X4 Configuration and Management - Mozilla Firefox

|_-] hitbp:fi192,168. 1. 1 fconfigfmobile/mobile _provisioning. hkm

in the mobile 2, This information is able from the

Mobile Device Provisioning is needed to properly configure the mobile device with the required
configuration used to access the mobile network, Typically, an automatic provisioning process
called OTASP {Qver the Air Service Programming) is used to provision the device, Note that
automatic provisioning requires the modem device to communicate over the mahile network
and requires a good signal to ensure proper provisioning.

Alternatively, a manual provisioning method can be used to manually specify the required fields
needed to access the mobile network. The manual provisioning method is an advanced
configuration normally used only for custom network access or providers,

@® Automatically provision the mobile device

C Manually provision the mobile device

<< Back ” Mext == l [ Cancel l [ Help ]

Dane P

Figure 75: Mobile Device Provisioning
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4. Continue to go through the mobile provisioning process until you see the following screen.
This screen will indicate that the mobile provisioning process completed successfully.

10.21.6.124

= ConnectPort X4 Configuration and Management - Windows Internet Explorer E”E|E|
&4

Mobile Provisioning Summary
Verify the settings below and click Finish to complete the wizard.

The mobile device has been successfully provisioned for the mobile network. No further
configuration is necessary to communicate on the mobile netwaork.

[ << Back ][ Finish ] [ Cancel l [ Help l

Done @Internet Fgov | W00 -

Figure 76: Mobile Provisioning Summary

5. Click Finish to return to the Mobile Configuration page.
6. Click Apply on the Mobile Configuration page when finished.
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Verifying the Cellular Connection Status

Once the correct cellular configuration has been applied, the ConnectPort X4 will begin to establish the
cellular connection. You can verify the connection status by navigating to the Administration > System
Information > Mobile page.

System Information

¥ General
b Serial
b Metwork
¥ Mobile

SIM Information

The following information and statistics can be used to manage and monitor your mobile connection, This information may
also be helpful in troubleshooting problems with the mobile network,

ICCID: WA

Maohbile Connection

Mobile Statistics

Maohile Information

Registration Status:
Location Area Code:
Cell ID:

Signal Strength:

IP Address:

Primary DNS Address:
Secondary DNS Address:
Data Received:

Data Sent:

Idle Resets:
Inactivity Timer:

Slot  IMSI and ICCID Phone Number  Status PIN Status  Active
1 310410265385546 19522212376 Primary Ready J
89014104232653855469
2 IMSI; Mia [{ Y Mot configured  MAA J

Registered (Home Metwork)
0xDEEF (55023)
0%959E (38558)

|:|D|:||:||:| (-88 dBm)

166.130.120.49
209.183.33.23
209.183.33.23
30222 bytes
42321 bytes

26

23600 seconds (receiving)
0 seconds {sending)

Figure 77: Verification

NOTE: In the above example, the ConnectPort X4 is connected to the cellular network and has obtained
the 166.130.120.49 address for its cellular interface.
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CDMA Cellular Configuration Example (Sprint)

NOTE: This example assumes that the ESN/MEID# for the ConnectPort X4 has been activated with
your cellular provider. You can find the ESN/MEID# on the bottom of your unit.

To configure a CDMA ConnectPort X4 cellular interface perform the following steps:

1. Click on Configuration > Mobile from the left-hand menu and select Sprint PCS from the Service
Provider drop-down menu. You should see a screen similar to the following:

Mobile Configuration
w Mobile Settings

Select the service provider, service plan, and connection settings used in connecting to the mobile network.
These settings are provided by and can be retrieved from the service provider.

Mobile Service Provider Settings

Service Provider: Sprint PCS v

This device needs to be provisioned:
Update the preferred roaming list (PRL): Update

Mobile Connection Settings

Re-establish connection when no data is received for a period of time

Inactivity timeout: 3600 seconds

[ Apply ][ Setto Defaults

» GPS Settings

» SureLink Settings

» Short Message Service (SMS) Settings

Figure 78: Mobile Configuration

2. After selecting a Service Provider, the unit needs to go through its provisioning process. Click the

Provision Device button, and then follow the steps displayed within the Mobile Device Provisioning
dialog screens.

NOTE: The default options within the Mobile Device Provisioning dialog screens will be correct
for most installations.
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3. When the following screen is displayed, select the Automatically provision the mobile device

option.

{= ConnectPort X4 Configuration and Management - Windows Internet Explorer, [:J|E|E|
&

10.21.6.124

Mobile Device Provisioning
Specify the method in which to provision the mobile device. This information is available from the
mobile provider.

Mobile Device Provisioning is needed to properly configure the mobile device with the
required configuration used to access the mobile network. Typically, an automatic
provisioning process called I0OTA (IP-Based Over the Air) is used to provision the device. Note
that automatic provisioning requires the modem device to communicate over the mabile
network and reguires a good signal to ensure proper provisioning.

Alternatively, a manual provisioning method can be used to manually specify the required
fields needed to access the mobile network. The manual provisioning method is an advanced
configuration normally used only for custom network access or providers.

® Automatically provision the mobile device

 Manually provision the mabile device

[ << Back ” Mext == ] [ Cancel ] [ Help ]

€ Internet fa v H00% v

Figure 79: Mobile Device Provisioning

Done

4. Continue to go through the mobile provisioning process until you see the following screen. This
screen will indicate that the mobile provisioning process completed successfully.

{= ConnectPort X4 Configuration and Management - Windows Internet Explorer. E“Elgl
&4

10.21.6.124

Mobile Provisioning Summary
Verify the settings below and click Finish to complete the wizard.

The mobile device has been successfully provisioned for the mobile network. No further
configuration is necessary to communicate on the mobile netwaork.

[ << Back ][ Finish ] [ Cancel ] [ Help ]

Done & Internet fg v | W100% -

Figure 80: Mobile Provisioning Summary

5. Click Finish to return to the Mobile Configuration page.
6. Click Apply on the Mobile Configuration page when finished.
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Verifying the Cellular Connection Status

Once the correct cellular configuration has been applied, the ConnectPort X4 will begin to establish the
cellular connection. You can verify the connection status by navigating to the Administration > System
Information > Mobile page.

System Information

¥ General
b Serial
b Metwork
¥ Mobile

SIM Information

The following information and statistics can be used to manage and monitor your mobile connection, This information may
also be helpful in troubleshooting problems with the mobile network,

ICCID: WA

Maohbile Connection

Mobile Statistics

Maohile Information

Registration Status:
Location Area Code:
Cell ID:

Signal Strength:

IP Address:

Primary DNS Address:
Secondary DNS Address:
Data Received:

Data Sent:

Idle Resets:
Inactivity Timer:

Slot  IMSI and ICCID Phone Number  Status PIN Status  Active
1 310410265385546 19522212376 Primary Ready J
89014104232653855469
2 IMSI; Mia [{ Y Mot configured  MAA J

Registered (Home Metwork)
0xDEEF (55023)
0%959E (38558)

|:|D|:||:||:| (-88 dBm)

166.130.120.49
209.183.33.23
209.183.33.23
30222 bytes
42321 bytes

26

23600 seconds (receiving)
0 seconds {sending)

Figure 81: Verification

NOTE: In the above example, the ConnectPort X4 is connected to the cellular network and has obtained
the 166.130.120.49 address for its cellular interface.

iDigi Gateway Development Kit Getting Started Guide — Wireless WAN Version



Appendix C: Configuring for WiMAX Networks

This Appendix provides an overview of how to configure the Wireless WAN interface of the ConnectPort
X4 for WiMAX networks.

This Appendix also describes how to view the ConnectPort X4 Wireless WiMAX connection status, and
its IP Gateway priority list.

Step 1: Connecting to the ConnectPort X4 Home Page

1. Connect one end of the provided Ethernet cable to your PC, and the other end to the
ConnectPort X4 Ethernet port (ensure that your PC is configured to obtain its IP address via
DHCP).

2. Open the web interface of the ConnectPort X4 by navigating to the 192.168.1.1 address in a web
browser on the PC. You will see a screen similar to the following (this is the device’s Home
page):

ﬂ, ConnectPort X4 4G Configuration and
1"; b Management

@ Hep

Configuration Getting Started
MNetwork
WHMA Tutorial Mot sure what to do newt? This Tutorial can halp.
“Bee Natwork
Senal Ports System Summary
Cameara
Alarms Model: ConnectPaort X4 4G
System Ethamat MAC Address: 00: 40:90:50:09:C2
iDigi Wik A MAC Address: 20: FC:8F 08 5F1E3
Users
Posrtion Ethemet IP Address:  192,168.1.1
Applications Wi¥iMAE TP Address: T5.92,117.159
Python
RealPort Description: Mone
Industrial Automation Contact: None
Management Location: Mone
Serial Ports
Connections Device [0 00000000-00000000-004090FF-FFE009C2
Ewvent Logging

Network Sarvices

Administration
File Managemant
®.509 Certificate/Mey
Management
Backup,/Rastore
Update Firmware

Factory Default Settings

System Informatior

Feboot

Lagout

Figure 82: ConnectPort X4 Home Page
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Step 2: Configuring the Wireless WAN Interface for WiMAX
Networks

NOTE: This example assumes that the WiMAX (WAN) MAC address for the ConnectPort X4 has
been activated with your WiMAX provider. You can find the (WAN) MAC address on the bottom
of your unit.

The WiMAX activation process for a ConnectPortX4 behaves more like WiFi than Cellular CDMA. Instead
of activating an ESN or MEID on the cellular network, and then provisioning the ConnectPort X4 with the
appropriate cellular network settings, once the Wireless WAN WiMAX MAC is activated on the WiMAX
network the ConnectPort X4 may automatically establish its WiMAX connection.

This example assumes that the ConnectPort X4 has already been activated on the WiMAX network. As a
result, you can refer back to the ConnportX4 Home page (displayed on the previous page) and observe
that this particular unit has already obtained a WiMAX IP address.

In the event you need to modify this configuration, perform the following steps:

1. Click on Configuration > WiMAX from the left-hand menu and you should see a screen similar to
the following:

WIMAX Configuration

Radio Settings

These settings control the behavior of the radio when the ConnectPort X4 4G is started.

Enable the WiMAX radio

Automatically connect to the selected subscription:

WiMAX Subscriptions

Operator RName MNSP-ID  Activated
Clear Clear oooooz Ves
Clear Sprint 4G oooooz Yes
Clear Sprint PCS 000002 Yes

L1 Enable user authentication

[ Apply ][ Set to Defaults

Figure 83: WiMAX Configuration

2. By default the ConnectPort X4 enables the WiMAX radio and attempts to connect to the best
available network based on all the active subscriptions. In the event you wish to select a specific
WiMAX subscription, click the appropriate WiMAX subscription (Sprint 4G in this example), then
click Apply.
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3. Before the ConnectPort X4 attempts to establish this new WiMAX configuration, the existing
WiMAX connection needs to be disconnected by clicking Disconnect.

Metwork Connection

These options may be used to make a manual connection.

® connect with automatic network selection
Select 3 subscription from the list above,

O Connect to a specific netwark

Select 3 subscription from the list above, and 3 network from the izt balow,

WiMAX Metworks

Mame  Type NAP-ID RSSI CINR
Clear Horme ooonoz -65 dBm 14 dB

Fefresh ” Scan ]

Radio Status: Connected to Clear (000002%
See detailed radio information

Connect ” Disconnect ]

Figure 84: Network Connection

4. At this point the ConnectPort X4 has no WiMAX connection established. Click Connect in order
to establish the new WiMAX connection.
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Step 3: Viewing the WiMAX Connection Status

1. After a few moments, you can check the WiMAX connection status by navigating to the
Administration > System Information > WiMAX page. You should see a screen similar to the
following displaying the active Subscription Name (Sprint 4G in this case) as well as additional
WiMAX information.

System Information

P General
P Serial
b Metwiork

* WiMAX

with the Wikax network,

Connection Information

Hetwork Information

The following infarmation and statistics can be used to manage and monitor your
Wikax connection. This infarmation may also be helpful in troubleshaoting problems

Fadio Status: Connected
Connection Duration: 00:00:04
Disconnect Reason: User Requested
Subscription Name: Sprint 4G
Metwark Type: Home
Map-I0: oooooz
RSSI: -565 dBrmn
CIMR.: 17 dB
Signal Quality: ml D |:||:| {4 of 5 bars)

IP Address: 75.92,117.159
Gateway: 75.92.64.1
Primary DMS: 66.233.169.12
Secondary DNS: 64.12.115.12
Data Received: 1180 bytes
Data Sent: 984 bytes

Fadio Module Information

Figure 85: System Information
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Appendix D: Troubleshooting

XBee® devices fail to join the ConnectPort X4’s XBee® network

Is the ASSC LED solid green?

If the ASSC LED is solid green on the XBee Sensor, XBee Smart Plug, or XBee Wall Router, it
indicates that the XBee device is waiting to join a network, but has been unable to do so (once it
joins it will blink its ASSC LED). This condition may mean one of two things; the ConnectPort X4
is turned off, or the XBee device is out of range of the ConnectPort X4.

To troubleshoot this problem, move the XBee device closer to the ConnectPort X4 and/or
ensure that the XBee device is turned on.

Is the ASSC LED blinking green?

The XBee Sensor, XBee Smart Plug, or XBee Wall Router will blink their ASSC LED when they are
attached to a ZigBee network. If the XBee device has a blinking ASSC LED, but the device does
not appear in the list of XBee devices connected to the ConnectPort X4, then the XBee device
has either connected to the wrong ZigBee network, or the ConnectPort X4 simply needs to
rediscover the list of its attached XBee devices.

To troubleshoot this problem, first try clicking the Discover XBee Devices button on the
ConnectPort X4's XBee Network page as described on page 35. If this is unsuccessful, move the
XBee device closer to the ConnectPort X4 (and if possible configure the devices on the other
XBee network to block network joins).

Once the XBee device has been moved closer to the ConnectPort X4, factory reset the XBee
device (in order to force the XBee device to go through its XBee network discovery phase again).
To factory reset an XBee device, simply press the reset button on the side of the unit 4 times (at
a rate of 2 times per second). Once this is done, the XBee device should connect to the
ConnectPort X4's XBee network, and then show up in its list of attached XBee devices (as
described on page 35).

If this fixes the problem, return to the “Step 5: Create your first iDigi Dia Project” section and
proceed with Step 12 on page 35.

If your devices still are not appearing in the XBee devices list, please contact Digi’s Technical
Support (see Contact Information on page 3).
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iDigi Manager Pro™ does not discover your ConnectPort® X4

If it is not practical to install JRE 1.6 or newer on your PC in order to allow the auto-discovery
process to properly configure your ConnectPort X4 to communicate with iDigi, you can configure

the device manually by following these steps:

1. Add the ConnectPort X4 to your iDigi inventory by clicking the Add Manually button and
then entering the MAC address (found on the bottom of the device) into the
appropriate field. After the MAC address is entered, click the Add button.

2. After your ConnectPort X4 MAC address entry appears in the list, click the OK button to

add the device to your iDigi inventory.

Note: When entering a MAC address use the following format XXXXXX:XXXXXX.

Home Devices
Welcame -

Resources -
Search ¥

Management WAL Address Device ID IP Addiess Device Tupe Deseription
Dievices @ 004090 40808F 00409dF F-FF4ab0bt 10.21.6.178 ConnectPort x4 Gateway Dev Kit Demo

4

HBee Metworks
Storage
WWeb Services Console

Subseriptions Add Devices

Summary

Details Enter a device's MAC address and click Add for each device you want to add. Ifthe device doesnthave a

MAC address then add it by IMEI number ar device 1D, (Click here for details.)

Administration Tofind devices on the local netwark click the Launch discower hutton. Vwhen you are done click OK.

My Account
Massages
Shera one MAC Address: - [ || 0 Add

MAC Address Davice ID % Remove

004090:43B08F 00000000-00000000-004090F F-F F49BOEF

== Discover  Find your device on the netwark
1 devices to add (0 discovered, { manuall
0K Cancel
Ready

Status Firmware Level

Connectad 21208

1 devices

Figure 86: Manually Adding a Device to your iDigi Inventory
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3. At this point in time, the ConnectPort X4 has been added to your iDigi inventory, but the
device itself has not yet been configured to establish a connection to iDigi. To configure
the ConnectPort X4 to establish a connection to iDigi, follow the steps below.

a. If you know the IP address of the ConnectPort X4, connect to its web Ul by
entering its IP address in your web browser.

If you do not know the IP address of the unit, use the Digi Device Discovery tool
in the Start Menu, and double-click on the device to open its web Ul.

b. Click the iDigi link to configure the device’s remote management configuration
options. In the Digi configuration settings page, enter the DNS name of the iDigi
Cloud (developer.idigi.com) into the iDigi Server Address field under the “Enable
Device-Initiated iDigi Connection” section.

c. Click the checkbox labeled “Automatically reconnect to iDigi after being
disconnected” then click Apply.

iDigi Configuration

For more information about iDigi and how to remotely configure and manage this device, please visit www.idigi.com.
For more information on configuring the iDigi settings for this device, see the iDigl Configuration Help.
iDigi Device Type: ConnectPort X4
+ Connection Settings
Device-Initiated iDigi Connection
¥| Enable Device-Initiated iDigi Connection
iDigi Server Address:  developer.idigi.com

Y| Automatically reconnect to iDigi after being disconnected

Reconnect after: 0 hrs 0 mins 10 secs

Server-Initiated iDigi Connection

Enable Server-Initiated iDigi Connection
Enable Device IP Address updates to the following server

iDigi Server Address:
Retry if the IP Address update fails

n n

Retry after: |0 hrs |1 mins |0 Secs

Apply

» Advanced Settings

Figure 87: iDigi Configuration Page

The ConnectPort X4 will now attempt to establish a connection with iDigi, if the device is on a
network with Internet access, the connection should be established in less than a minute. With
the ConnectPort X4 properly configured to communicate with iDigi, and with the device added
to your iDigi inventory, return to the “Add the ConnectPort X4 to your iDigi inventory” section
and proceed with Step d on page 18.
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iDigi Manager Pro™ lists the ConnectPort® X4 as ‘Disconnected’

This condition indicates that the ConnectPort X4 and iDigi are not communicating with one
another. This can occur for several reasons:

1. If the ConnectPort X4's Wireless WAN interface has the highest Gateway priority,
make sure the Wireless WAN interface is up.

2. If the ConnectPort X4's Ethernet interface has the highest Gateway priority, make
sure the Ethernet network has Internet access.

3. The ConnectPort X4 is unable to resolve the DNS address of "developer.idigi.com."

4. If you added the ConnectPort X4 to iDigi inventory manually, the MAC address
provided to iDigi may not match the actual MAC address of the ConnectPort X4.

5. The ConnectPort X4 is not configured to establish a connection with iDigi.

If you have verified that all five of these scenarios are not occurring please contact Digi’s
Technical Support (see Contact Information on page 3).
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